
PdfBooklet 2.2.2 

PdfBooklet first  purpose was to create  booklet(s)  from existing pdf files.  It  has been
extended to many other functions in pdf pages manipulation.  

There are already multiple software which creates booklets, but none had all the features
we needed for a precise printing :

• Multiple booklets

• Add blank pages in the beginning and the end

• Adjust scale and margins. 

All  this  is  necessary when you  want  to  print  in  duplex  a  pdf  because  generally  the
margins are not correct and the even and odd pages don't correspond exactly, or the internal
margin is too small and reading may be difficult (for a big book), or external margins are too
small  and the  binder  will  have  problems etc.  Sending back the  file  to  ask to  correct  the
margins was a problem : you will ruin a layout if you change the margins of a file ! It was
better to adjust the pdf itself. With PdfBooklet we can do a precise job in minutes, and since
the software was useful for us, we decided to share it with others. 

1. Quick discovery
The best way to understand what is  pdfbooklet  is  to run it,  open a  pdf file,  select  a

disposition, and use the preview buttons to see what the output file will be like. Here is what
you will see with the default values and the sample file  France – wikipedia.pdf  (yes, pdf-
booklet is French). 



Now test with a different disposition : 

Click on a page on the right to select it, and click Transformations 



Change Rotation to 20 . The selected page is rotated. 

Click the > button : you will see that all pages at the given position are subject to the
same transformation. This can be avoided if you want to change a single page : just check
« This page only » in the dialog before making your changes. 

Other (more useful) transformations include scaling and moving the text. In our example,
the pdf file generated by Wikipedia has page numbers at the limit of the page. This will not be
printed by a standard printer. So we need to reduce the text a little, and move it to the top :



When you are happy with the result, verify in the Options thaat « Show Pdf » is checked,
and click the « Go » button. After a moment the new file appears in your Pdf Reader. This
new file is saved in the same directory as the source file, with « -bklt » added to its name
(France – wikipedia-bklt.pdf in our example). You can change this in the Options dialog. 

Now if you have a duplex printer (they are more and more common today), print the new
Pdf in duplex,  don’t forget to set the duplex option to short  side, fold the output of your
printer, staple the booklet, and you are done. Pdfbooklet has been written for that. 

Don’t fear to test, pdfbooklet is safe because it cannot overwrite your original file, even if
you try to. With the default options, it will create a new file in the same directory with “-bklt”
added to the file name.  

2. Features
Create a booklet or multiple booklets from a pdf file.

• Print multiple pages on a single sheet (without limitations to the number of rows and
columns)

• Dispose the pages on the sheet in any order you want.

• Multiple copies of the same page are possible on the output sheet. Examples with four
pages on a sheet :

◦ Pages 1,2,3,4 / 5,6,7,8 … (one copy of each page)

◦ Pages 1,2,1,2 / 3,4,3,4 … ( 2 copies of each page)

◦ Pages 1,1,1,1 / 2,2,2,2 … (4 copies of each page)

• Add blank pages anywhere in the output file

• Transform pages :

◦ Change margins

◦ Scale

◦ Rotate

• Multi files mode : All these operations are possible with pages from different Pdf files

• Extract pages from pdf files.

• Merge pdf files

3. What's new in 2.2
• User defined disposition has been added (see chapter 6, below). 

• Imposition  program  for  the  poor  :  with  the  new  “user  defined”  option  for  the
disposition, PdfBooklet can now be used as an imposition program for the poor with
some tricks which are explained in the HowTo. (It will not have all the features of a
professional program, but they are so expensive...



• You can now open directly PdfBooklet by a right click on a file,  if  you associate
PdfBooklet to the extension. See HowTo below for details

• If you use PdfCreator for creating your pdf files, you can directly open the output in
PdfBooklet. See HowTo for details

4. Limitations
The pdf format  is  quite  complex and the pypdf  library used by pdfBooklet does not

support all the features of the pdf-format. Here are some known limitations :

LZW compression is not supported and will not be supported because it is a proprietary
format and requires a license.  Example : the documentation of PGP cannot be opened by
PdfBooklet because it is compressed with LZW

Some  Pdf  files  had  errors  on  particular  pages  because  of  an  error  in  the  gzip
decompressor (returned code -5). PdfBooklet tries to continue, but the output page may be
blank. 

Some  Pdf  files,  although  correctly  opened  in  PdfBooklet  produce  a  huge  output.
Example : the Developer’s guide of Open Office is a 17MB file which contains 1250 pages.
Output from PdfBooklet is valid, but each page takes about 8MB. The file size would be
10GB ! The reason of this anomaly is that this file includes the resources of all pages (images,
fonts …) in each page as a list. pyPdf extracts all resources, and add them not as a list but in
full to each page which results in a huge waste of space. 

Pdf format allows adding annotations which are not really embedded in the page but are a
different  layer.  The pyPdf library does not take this into account,  only the “real” page is
handled and annotations may disappear.

5. The Menus
Files

File manager

The file manager lets you open one or several files, and lets you modifiy the order of
opened files :



You have two ways to use it :

1. Select the files in the upper part and click “Open Selected File(s)”

2. Select one or more files and click on the + button. The file(s) is (are) added to the list.
You may select files from different directories. You may delete some file from the list
with the x button, move up or down a particular file in the list by drag and drop (or
with the ↑ and ↓ buttons if you  prefer) or start a new list (clear the existing list) with
the             button. 

Once your list is OK, open it with “Open File(s)” in the list.

The output file will be created in the same directory as the source file (the first source file
if you have more than one file opened), with the same name + -bklt.

You  can  change  this  default  behavior  in  the  Options  tab.  See  details  below  in  the
description of this tab. 

Projects
When  you  have  worked  on  some  file(s)  and  made  some  delicate  adjustments,  it  is

recommended  to  save  all  the  settings  with  it  otherwise  if  you  want,  later,  to  modify
something,  you  will  have  to  do  the  job  all  over  again.  You can   do this  in  two ways  :



Automatically, by checking the option  Save settings with pdf  in the  Options  tab. When this
option is checked, each time you create a pdf file, an ini file with the same name that the pdf
file + “ini” is created in the same directory. If you move the pdf file, remember to move also
the corresponding ini file. You can also use the Save Project menu. The Open Project menu
lets you reload an ini file. The ini file includes the list of files, the pages selected, and the
transformations done on the pages. The ini file is human readable and you can open it to see
what were the settings used. 

Saving a project is also useful when your work on a set of files is unfinished. 

WARNING : this feature is not perfectly implemented and sometimes your ini file may
be updated when you don't want it to be. So, it may be prudent to save a copy of the ini file in
a safe place, if it is important for you, before working again on a file. 

Save settings as default
The default settings of the interface may not be the best for you. Just select what you

want and use this menu to save your settings. This does NOT include the file(s) name(s). If
you to save everything with the file names and pages selection, use a Project. 

Pages
The Pages  menu lets you select the pages. If you don’t want to include all pages in the

output file, use the pages selector to select and organize your pages : 

• move pages at a different place (with drag and drop)

• delete pages (right click)

• add blank pages (right click)



The pages selector is in fact the program Pdf-Shuffler, written by Konstantinos Poulios,
which  is  opened  inside  Pdf-Booklet.  You  can  also  use  Pdf-Shuffler  independently,  Pdf-
Booklet installer has created an icon for it. 

You can delete several pages simultaneously.  Use CTRL or SHIFT as usual to select
several pages, then right click and select Clear. 

You can move pages with drag and drop.  

Moving several pages simultaneously is possible.  When you click on the selection to
drag it, the selection disappears, but all the selected pages will be moved nevertheless. 

TRICK : When you move a single page, if you click and then drag without releasing the
button, the image of the page is moved also and it may be difficult to see the exact place of the
drop. To prevent this, click once to select your page, then click again to drag and drop, the
image will not move and drop is easier. 



You can adjust the scale with the slider on top of the screen : 

Sometimes it may be easier to edit directly the pages list. And it is more secure if you are
modifying the pages several times.  

Use the menu Pages / Edit Page List for this purpose : 



You can use :

• Page numbers

• Pages range separated by - (example : 1-20)

• b to indicate that a blank page must be added. 

• #b (example : 5b) to add 5 blank pages. 

All elements of your selection can be placed on different lines or can be separated by
commas. 

1-10, b, 24

or :

1-10

b

24

will give the same result.  

Pages can be listed in any order. You can list the same page multiple times, and ranges
can overlap. Although a nonsense, the following selection is perfectly valid :

20-50, 1-10, 5, 5, 6-40

If you have selected multiple files, for all files but the first, you must indicate the number
of the file followed by a colon. Example 2: for the second file. 



You can use 1: for the first file, but this is not necessary since 1: is the default. Example :

1-10
2:4
1:7 
2:22-50

 

6. The main window
The main window is divided in two : the commands on the left, and the preview on the

right. This preview shows an exact result of your settings. The output is calculated by the
same process which will produce the definitive output. You can resize the window to have a
larger preview (try full screen). 

You can select a page by clicking it. It will be surrounded by a red frame (see examples
above in the quick discovery. 

At the bottom of the preview there is a toolbar : 

<< : First page

< : Previous page

Text area : shows the active page (page of the output file). Enter a page number and hit
Enter (or click update) to go to the desired page. 

> : Next page

>> : Last page

Update : Update the preview (often unnecessary because update is most of the time
automatic, but not always).

Transformations : Opens the transformations window

Go : Generates the output file. 

On the right, the program indicates the total page count of the output file and the number
of pages already generated. Generation speed may vary hugely depending on the content of
your output file : Very fast when you work on a single file (up to 100 pages / s) it may be
much slower when the program must merge pages from different files in the same sheet (it
may be as low as 2 pages /s). 

Transformations
The transformations button is very important. It opens the little window which will allow

you to fine tune your documents. 



Since the result of what you do here is immediately visible, it is not useful to explain all
in details. Here is a possible example, just to show what is possible : 

We  have  not  checked  the  option  this  page  only.  The  consequence  is  that  the
modifications are applied to every pages in the same position (right page in this example). If
you want to modify a single page, check this page only. The other pages will not be modified. 

The  Apply Button will apply the changes but is seldom necessary, because updating is
generally automatic. 

LIMITATIONS : It is not yet possible to select several pages, you must modify them
one at a time but remember that if This page only is not selected, transformations applied to a
page will be applied to all pages which are in the same position. 

You can copy and paste transformations : right click on a page to get a context menu.



REMEMBER  :  if  “this  page  only”  is  checked,  you  will  copy  and  paste  only  the
transformations  applied  to  this  page  only.  If  it  is  not  checked,  you  will  copy  and  paste
transformations applied to all pages in this position.  

Standard Transformations offers you a shortcut for common rotations :

This context menu will be developped later. Custom transformations are not yet active. 



Disposition

In this tab you define the general disposition of your output page : booklet (or booklets)
or only multiple pages on a single sheet. Just click the different options to see what they do.  

1. Booklets (Single or Multiple)

In this mode the number of columns must always be a multiple of 2. Other values will be
corrected by the program. If you indicate more than 1 for the rows, or more than 2 for the
columns, you will have multiple copies of the same pair of pages. This is useful if you have
an A6 format booklet and you want to print two copies on an A4 page (A5 for both pages, A4
for two copies).  

The  Single Booklet  option will  create one booklet from the whole file.  If you select
Multiple Booklets, You can define the maximum number of leafs (sheets of paper) for a
booklet. Suppose you have a 60 pages document and you keep the default value (5), you will
get 3 booklets of 20 pages (5 x 4) each : 1-20, 21-40, 41-60. The program will add the needed
blank pages and try to equilibrate the booklets. If your document has 43 pages, a blank page
will be added, and instead of making two booklets of 5 sheets of paper and 1 of  1 sheet, the
program will reduce to 4 sheets the first two booklets, and the remaining booklet will have 3
sheets : 1-16, 17-32, 33-44.

Type Book or Calendar will define if the pages are positioned left-right or top-bottom. 



2. Multiple pages

The three following options (2 pages, x pages in  line, x pages in columns) are variants of
the same process : place a given number of pages of the source file in a single page of the
output page. 2 pages is the same thing as x pages in line with 1 line and 2 columns. Pages can
be set in lines or in columns : 

x pages in lines (3 lines, 3columns) x pages in columns (3 lines, 3columns) 



3. Multiple copies 

x copies will place multiple copies of the same source page in the output page. The total
number depends on the number of rows and columns you define.

Step :

By default, when you select this option, step is set to 1. If you define step to y, you will
get multiple copies of sets of y pages of your document. An example will show you what this
means : Below you have the result with step = 1 on the left, step = 3 on the right. 

If it is not clear for you, try with different values for step and see the result. It will be more
clear than a long explanation. 

4. One page

This option is used when you want to extract pages from a pdf file or to merge several
pdf files (or pages from these files) in a single pdf file. 



5. User defined

This is an advanced option which allows you to define the layout of pages on the sheet.
When you click on this option, a small window opens : 

Enter here the order in which pages must be placed on the output sheet. Follow theses
rules :

1. One line for each row of pages

2. Comma separated

3. If you repeat a number, the page will be placed multiple times on the sheet. In this
case you should define the step. See explanations below

4. You can create a blank page by entering a b

5. You are responsible to enter here coherent data. Each line must have the same number
of “pages” 

6. Numbers entered here are not page numbers. They indicate only the order in which the
pages will  be placed on the sheet.  (In the examples  below they do correspond for
easier understanding, but this is only a particular case, first page of an unmodified
pdf). 

Some examples below. 



Normal case

1,3,5,7

2,4,6,8

You  may  have  as  many  rows  and
columns you want :

1,3,5

7,9,11

2,4,6

8,10,12

Pages repeated

1,2,1,4
3,4,2,3



Blank pages 

1,b,b,2
b,3,4,b

The step parameter

If you repeat pages in your layout, like this example :

1,2,1,2

3,4,3,4

Then if you leave the parameter “Step” to “Automatic”, the program will calculate the
step on the base of the total number of pages. In this case it will be 8 (2 x 4). This means that
the first sheet will contain pages 1 to 8, and the second will contain pages 9 to 16. The result
will be is : 

First sheet Second sheet

1,2,1,2
3,4,3,4

9,10,9,10
11,12,11,12

And pages 5,6,7, and 8 will never be displayed, which is surely not what you expect !

So you MUST indicate that the step is 4 and then you will get : 

First sheet Second sheet Third sheet

1,2,1,2
3,4,3,4

5,6,5,6
7,8,7,8

9,10,9,10
11,12,11,12

 

Output size

In  the  disposition  tab  you  find  also the  frameOutput  size.  This  frame allows  you  to
indicate the size you want for the output page. 



• Auto :  With this option,  no scaling is done. The size of the output page will  be a
multiple of the size of the source page (of the reference page to be precise ; See the
description of the Options tab to find an explanation about the reference page). If your
source file has A5 pages, and you have chosen the option booklets with one row, then
the output page size will be A4. If you had selected multiple pages with two rows and
two columns, then the output page will be A3. And so on. 

• No change :  The  output  page  size  will  be  the  same  as  the  source  page  (  of  the
reference  page  to  be  precise ;  See  the  description  of  the  Options  tab  to  find  an
explanation  about  the  reference  page).  Whatever  your  selection  about  rows  and
columns, if your source file has A5 pages, your output pages will be A5 and the pages
you place on it will be scaled. 

• User defined : Define here the value you want (Width first and then Height) if the
previous options don't meet your needs. Please, be careful that you will probably have
to adjust the scale to get the result you want. This option is powerful but less easy to
use. 

Auto Scale : This option is normally checked and have a precise signification that you
must understand : If you have source pages of different sizes, it will insure that each page is
scaled to fit in the place reserved to it in the output page. An example will be more clear than
this explanation. Suppose we are merging two files, one in A5 format and the other in A4. If
auto scale is on, there is no problem :

The right page, which is in A4 in the source file, is correctly positioned. 

If Auto scale is off, this page will not be scaled and it will not fit in its place, it will be
croped : 



In some particular  situations it  may be useful to set  auto scale off, but this  is  rather
uncommon. 

There is presently no option to insure an automatic scaling of the whole page in case you
choose the user defined option. This may be added in a next version. 

Global transformations

The  Global  transformations  tab  lets  you  apply  transformations  similar  to  those
explained  above  (see  5.  Transformations)  to  the  output  page  as  a  whole.  To  add
transformations for the individual source pages you have placed on your output page, use
the transformations button under the preview. 

Horizontal Shift will move the page right (positive value) or left (negative value). 

Vertical Shift will move the page upper (positive value) or lower (negative value).
These values are in mm. Decimal values allowed 25.33 means 25.33 mm. 



Scale will enlarge or reduce the page. 
Values are in %. The fix point is the center of the page.

Rotation will rotate the whole content of the output page. . 

You may have to click update under the Preview to have the Preview updated. This
happens when you type a value and don't use the arrows. 

The Reset button will restore the default values ( =  no change). 

Global rotation
This point may be difficult to explain with words, but the example will help. The Pddf

format has two different mechanisms for rotation.  One is applied to the content.  It  really
rotates the content, and you can rotate the angle you want. Another is applied to the page
itself, not the content of the page (just as if you turned the sheet of paper) and has only four
possible values : 0, 90, 180, 270. 

Original page Rotation of 90° using Output 
Page Transformations : 
The content is rotated, 
not the page. 

Rotation of 90° using Global 
Rotation : 
The page is rotated with the 
content. 

You will notice that Output Page Transformations rotates counter clockwise and Global
Rotation rotates clockwise. We are not responsible of that, this is how Pdf works and there is
a reason for it : The first system is an internal process and uses the standard of trigonometry
which rotates counter clockwise. The second process is user oriented and it is more natural for
humans to think of a clockwise rotation (this is purely cultural, indeed). 

Options 
The Options tab gives access to advanced features :

Leading blank pages : number of blank pages to add in the beginning of the document.
This is intended for traditional binding which requires blank pages in the beginning
and the end. 

Trailing blank pages : number of blank pages to add in the end of the document. 
Right to left : For languages written from right to left, like Hebrew or Arabic, the layout



must be mirrored. 

Reference page : This is an important feature : by default the program takes the size of
page  1  as  reference  to  calculate  the  output  size.  If  your  document  has  pages  of
different  sizes,  this  may lead  to  undesired  results.  A common example  is  Google
books : There is always in the beginning of the file two information pages which are in
Letter format. The book after that may have very different sizes, and most of the time
it is not in letter size. If you need to control the size of the output page, you may have
to use this parameter to indicate the proper reference page (3 for Google books, or
even more than 3 in case the cover page has also a special size)

Output
The Output frame in the Options tab gives you control on some aspects of the output file.

Output file  name : By default,  Pdf-Booklet  creates  the output  file  name by adding
-bklt.pdf to the file name (without the extension) of the source file name. If this does not
meet your needs you can change this behavior here. 

In the Output file field, you may choose a file, but this is not recommended because the
file will be overwritten. But it may be used if you have a file that you generally use for your
tests and which can be overwritten. 

The normal way is to use parameters as in the default shown above : 

The %F code will be replaced by the actual file path and name, without the extension,
then -bklt.pdf is added to it. 

You can change this, but it must be noted that the %F parameter can be used only in the
beginning of the output file name because it is replaced by the full path, including the drive
letter (or the / in Linux). 

Other possible codes : 

%P :  Path

%N : Name

%B  : Basename

%E : Extension

Let your mouse on the Text field to get a tooltip :



Example : if the source file is D:\My Documents\Pdf files\testfile.pdf

Then :

%F = D:\My Documents\Pdf files\testfile

%P = D:\My Documents\Pdf files\

%N = testfile.pdf

%B = testfile

%E = pdf

• Show Pdf : if checked, the pdf file generated will be opened automatically at the end
of the process

• Save settings with pdf : if checked, when a file is generated, an ini file is created with
the settings you have used. Later if you want to do the same process on the same file
(or use the same settings for another file) you will not have to start again all your
tuning. This important when you have made sophisticated transformations. 

• Overwrite output files : if checked, there will be no warning if the output file already
exists. Note that you may still have a warning if the output file is already opened in
Adobe Reader, because it cannot be overwritten in this case. 

• Don't compress output : Today pdf files are generally compressed. In case you want
to have a look at the content, you can check this. Note that this will let uncompressed
only  the  content  which  pyPdf  has  manipulated.  Many  resources  will  be  still
compressed. This is a very technical option. 

Log
When you open a file and during the generation of the output file, some informations are
added in the log tab.  Presently this  is  a little  erratic  and will  be improved in the 2.0
version. Here is an example of what you may find in the log when treating a 69 pages
document with the default options. Text in the log is in black, explanations in blue. 

Size of source file =    209 mm x 297 mm Page size of source in mm

Size of output file =    419 mm x 297 mm Estimated size of output file



E:/Mes documents/en cours/PdfBooklet/DossierMicrosoft2009.pdf has 69 pages.

Blank pages to be added : 3 if using the booklet option, pages must be multiple of 4

Booklet 1 : pages 1 - 20 Creating the booklets layout

Booklet 2 : pages 21 - 40

Booklet 3 : pages 41 - 56

Booklet 4 : pages 57 - 72

Assembling pages: ['1:19', '1:0'] Pages are being assembled. 

Assembling pages: ['1:1', '1:18'] Values here are system values :

Assembling pages: ['1:17', '1:2'] First page is 0 and non 1. 

Assembling pages: ['1:3', '1:16'] 1:0 means first page (0) of first pdf file. 

Assembling pages: ['1:15', '1:4'] 

Assembling pages: ['1:5', '1:14'] 

(...)

Assembling pages: ['1:67', '1:60'] 

Assembling pages: ['1:61', '1:66'] 

Assembling pages: ['1:65', '1:62'] 

Assembling pages: ['1:63', '1:64'] 

Total length : 2.4849998951 Total time used for internal transformation. This 
does not include the output file generation.



7. HowTo...
Open a file in PdfBooklet with a right click

• Right click on a pdf file

• Select “Open with...”

• Select “Choose the default application”

• In the window select PdfBooklet if it is present in the list, or click on “Browse” to
choose it. 

• Uncheck “Always use this program to open this type of file”

• Click OK. 

Now, when you right click a pdf file, you will have an option to open it with PdfBooklet. 



Open a file generated by PdfCreator directly in PdfBooklet
Create a profile in PdfCreator and select PdfBooklet as Action after the creation of the

pdf file. See below (Sorry, our version is French, but it is not difficult to find the place in your
English version. 

You may also prefer to uncheck the option of opening the document with the default 
application : 



imposition program for the poor
If you don't know what is imposition, see : http://en.wikipedia.org/wiki/Imposition

Probably PdfBooklet will never be used for such a professional task, but in case you are
in real need of it and don't want to pay an expensive program, PdfBooklet is your friend. 

The problem is that imposition requires a different disposition for odd and even pages
and PdfBooklet cannot do that. But there is a simple enough workaround. Suppose you want
this :

• Select “User defined” in the Disposition tab.

• Set your disposition first the front pages :
5,12,9,8
4,13,16,1
in our example

• Set the step to 16 (very important). 

• Turn the pages so that they have the proper orientation

• Generate the file and call it MyFrontPages.pdf

• Repeat the process for the back pages and generate MyBackPages.pdf

• Now you don't have a duplex printer, print the first file and then the second. 

• If you have duplex printer, you need to merge the files. 

http://en.wikipedia.org/wiki/Imposition


• Open the two generated files in pdfbooklet and select the disposition “One Page”

• Select the menu Pages / Edit pages list

• Set the page list as follows :

1:1, 2:1

1:2, 2:2

1:3, 2:3

1:4, 2:4

and so on. 

• Generate the file

• You are done. 

8. A real life experience. 

You have just got on Google a pdf of an old book now in the public domain and you
would like to have a beautyful  copy.  So you plan to print  it  in booklets  and give it  to a
professional binder. Fine, pdfBooklet was designed for that. 

So you rush to the program, open the file, clic on start and … disappointment : 

1) The first two pages are the Google presentation, and you don’t want this in your copy

2) The format is bad, there is a lot of blank on the top and on the right. 

But this is not a problem, you have just to understand which corrections you must use in
the configuration. 

1) You don’t want the first two pages ? Just remove the first two pages with the Pages
menu.  

2) The first two pages with the Google information are in a “Letter” format. This may not
be the case of the rest  of  the book. Just  tell  the program which page to  use as a
reference. This is set in the “Options” tab. In our case, page 3 is fine.  

Now start again. You will find that the problems are corrected. 

 

9. Future of Pdf-Boolet

Improvements are possible. Some of them may be added later. 

1. Preview

1. Option to disable automatic update. May be useful when working with files with



lots of images. 

2. Disposition

1. Autoscale for the full page (useful when the size is user defined)

3. Global transformations

1. only this page

4. Log

1. Work in progress

10. Known bugs or limitations
• See also 3. Limitations, above, the most important limitations are explained there. 

• In the About dialog, the link to the Pdf-Booklet site does not work. 

• If you have selected a directory in the file manager and click Open, nothing happens
(normal), but the directory is added to the list of most recently used files. This should
not happen. 

• When you use the pages selector, the first thumbnail is not updated when you load a
different file. You can easily force the update : just use the slider to change the scale
and all thumbnails, including the first will be updated. 
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